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Getting Started
The CAD software currently used by this unit for 2D drawing is GardenCAD. This can be purchased
and downloaded from the GardenCAD site using this link.

http://www.gardencad.net/web/

At the GardenCAD site you will find a variety or resources to help you with your CAD drawing. It a
good idea to spend some time becoming familiar with this site and its available tools. It is also a good
idea to revisit it regularly as content is constantly being updated. It’s important to note that though
TAFE lecturers will assist where possible with any issues you encounter during the course, any
problems you find with the product itself or its performance on your equipment will need to be referred
back to the vendor at this site.

The GardenCAD Interface
When you active the GardenCAD icon the GardenCAD interface will appear. You’ll note that all tools
are greyed out except the top 4 menu options
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To activate the interface you must either open an existing GardenCAD file or start a new drawing.
This is done by selecting File>New or File>Open from the top menu or selecting the New, Open or
Open Recent icons. (See Opening, Saving and Navigating Files later in this document)

The GardenCAD interface will become active and drawing can commence

Key Aspects of the Interface

Tools are grouped into Toolbar ribbons. You can turn these ribbons on/off by selecting View and
ticking the box to the left of the group.
Ribbons can be moved and placed around your workspace as you like.
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Left click and drag the band on the left hand side of a ribbon and place it where you like around the
workspace.
Place your mouse pointer over any of the tool icons and a popup will display what that icon
represents.
The GardenCAD tool set is broken down into 7 key groupings. Each of the sets relates to particular
drawing, editing or management functions. The Command line is a command, prompt and response
area where some tasks can be activated and managed by entering text commands directly through
the interface. For example, entering the word LINE or CIRCLE followed by the Enter key will activate
the drawing or editing command just as if you selected if from the menu. The command line is also
the area where a tool may request you to perform an action to complete the task. Functions that
require lengths or specific selections be made will appear here in the command line area.

The general rule of thumb when using the mouse during a CAD session is;
Left Click activates a task , responds to a task or places geometry into edit mode (geometry turns
pink)
Right Click terminates a function or selection
When using the command line any text command or response must be followed by Enter key
There may be some variation to this depending on the tool selected.
Once you become familiar with these core functions drawing will become much easier.
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The large black area in the centre of the frame is the drawing area or Model Space. This is where the
CAD drawings will be produced. There are other pages in the Pages area which will be described
later in the printing section. Vector graphic applications such as GardenCAD use The Cartesian
coordinate system to position the geometry in your drawing.

Opening, Saving and Navigating Drawings

To start a new drawing, select the New icon from the Standard Toolbar.
A popup will appear asking you to select a template.

If you have previously created a template document then select the template and press OK. If not
then select OK to open a new drawing.
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To open an existing drawing document select the Open icon. The file search popup will appear. Use
this to navigate to the folder where you have stored your previous drawings. If you are unsure which
drawing you are looking for, the Preview Panel will display a view of the drawing you have highlighted
in the File Name Window.

To open a recently used drawing select Open Recent. Selecting this will display a list of recently
opened documents. Select your file and Left Click OK.

Multiple Drawings can now be opened simultaneously in separate windows. If you select New a blank
drawing will open. If a grid of dots appear in the Model Space press F7 (function key) to toggle off.
This is a drawing grid which is best turned off unless required. Refer Using the Grid described later in
this document.
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To save your current drawing select the Save icon from the Standard Toolbar. Your drawing will be
saved to the same name and folder as it was when it was opened. If this is a new drawing and this is
the first time it is being saved the Save As popup will appear. Use this to choose a folder and
filename for your drawing. GardenCAD files are saved with a .vec extension to indicate it is a
GardenCAD vector file.

If you choose to regularly save your work during a drawing session and save as a different version
each time then select Save As from the File menu option from the top toolbar. When using any CAD
product it a good idea to save your work regularly. Make this part of your work process to avoid losing
your valuable work.
Once you have a drawing open you will need to be able to navigate around. You can do this by
selecting specific tools from the Standard Toolbar or use Keyboard/Mouse combinations while you
are drawing. This of the frame around your model space as a camera frame and you are manipulating
this with the zoom/pan tools to get a better view of your drawing.

To Pan – To Move your drawing Up Down, Left or Right within the Model Space use the Pan Icon
from the Standard Toolbar or hold the Middle Roll button down on your mouse while you drag. In
both cases your cursor will turn to a hand while active.
To Zoom In/Zoom Out – To move the view in or away from your drawing select the Zoom Icon from
the standard Toolbar. Your cursor will change to a magnifying glass with plus and minus. To zoom
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hold down you’re Left Button on your mouse and drag up to zoom in and down to zoom out. Rolling
your Middle Roll Button in or out on your mouse has the same effect.

To Zoom Window – To select and Zoom in on a specific part of your drawing select the Zoom
Window icon. When you select this Left Click and hold down while forming a box over the area you
wish to zoom in on. Left Click again once the box is formed and that section will fill the screen.
ZoomW<enter> to activate at the command line or the shortcut Ctrl-W
To Zoom Extents – To fill your screen with all of your drawing select the Zoom Extents Icon. This
selection looks at the out perimeter of all your drawing geometry and fits it into the Model Space. Use
Ctrl-E as a shortcut.
Zoom Previous – Repeats the previous Zoom selection.
Magnifier – Similar to the Zoom In/Out tool. While active a magnifying window appears in the bottom
right of your Model Space screen. As your mouse moves over geometry it’s magnified in this window.
To turn off just Left Click the Magnifier Icon so it’s toggled off.
The View Menu from the Top toolbar has two other view options. View Realtime and View selected
objects. View Realtime allows you to use Left Click or Middle mouse clicks to emulate zoom in/out
and pan functions. View selected enables you to zoom in an selected elements. Use the Left Click
key to select a piece of geometry so it turns pick. Select the View selected option and your view will
zoom in on just this element.
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Drawing Tools

The Draw Ribbon contains the key drawing tools for you to begin drawing. These tools can be
selected here or from the Draw dropdown from the top menu. This list contains a number of additional
tools and toolsets which will be described later in this document. The Draw ribbon contains the
primary tools to begin drawing.

Point - The smallest definable piece of geometry that can be drawn is a point. This can be draw by
selecting the Point Tool. You can also active this tool at the command line by typing the word POINT
<Enter>. In each case you will prompted at the command line to:
Specify a point:
This can be either a specific co-ordinate or a single Left Click at a chosen point on your drawing. A
single point will be displayed.

Line – A line is a straight piece of geometry with a start and end point. The Line tool is activated by
selecting the Line tool from the Draw Ribbon or typing the word LINE<Enter> at the command line. In
each instance you will be prompted at the command line to:
Specify first point:
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Either enter a specific co-ordinate or select a start point with a Left Click.
You will them be prompted to:
Specify next point:
Here you can specify a co-ordinate, Left Click a position for the line segment to end or enter a specific
unit length. As each unit is 1mm a length of 1000 with give you a line of 1 mm or 1 metre.
The Specify next point: prompt will continue to appear until you Right Click your mouse to terminate
the tool.

In this example a Line of 1000 units (1 metre) long has been drawn. The line tool will remain active
until the process is terminated with a Right Click.

Polar Tracking
In order to draw geometry that is perfectly Horizontal, Vertical or drawn at specific Angles, a drafting
Aid needs to be activated to help track these for you. In order to keep these angles under control
select the Polar button along the bottom of the command line. When you select this aid a yellow label
will appear just beneath your cursor as you draw. If your line meets one of the angle increments you
have set it will display that angle in the label.
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In this case the label displays 0˚ which is horizontal on the x axis. If it were 90˚ the line would be
vertical.
You can set these increments by placing your mouse anywhere inside the model space and pressing
Right Click on your mouse. A menu will appear. From this select Drafting Aids and the Drafting Aids
setup will appear. Select the Polar Tracking Tab.

In this tab you can set the polar tracking Increment Angle. In this example it’s set to every 45˚. The
tick next to Polar Tracking needs to be on for it to work. The Function Key F8 toggles polar tracking
on or off depending on its current state.

Create Infinite line – Will create a dotted line useful as a guide line. Select the Infinite line icon
or type XLINE<Enter> at the command line. In both cases you’ll be prompted to:

Specify base point:
Either enter a specific co-ordinate or select a start point with a Left Click
Specify through point:
Either enter a specific co-ordinate or select a start point with a Left Click
This will produce an infinite dotted line running through these two co-ordinates.
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Multiline Parallel – Creates a line made of two parallel lines. Select the Multiline Parallel Icon
or type MLINE<Enter> at the command line. In both case you’ll be prompted to:
Specify first point:
Either enter a specific co-ordinate or select a start point with a Left Click
Specify next point or [End/Close/Undo]:
Either enter a specific co-ordinate or select a start point with a Left Click.
This tool will remain active until you terminate it.
End will stop the drawing process.
Close will draw a parallel line from your current position to the start point closing a loop of parallel
lines.
Undo will remove the last line segment you have drawn,
While this tool is active if you select Right Click a popup will appear with the End/Close/Indo options
available so you do not have to enter at the command line.

Polyline – A polyline is a chain or line segments treated as one piece of geometry. You can create
a continuous line with the Line command but each segment is treated as single geometric entities.
To draw a polyline select the Draw polyline icon from the Draw ribbon or type PLINE<Enter> at the
command line. In both case you’ll be prompted to:
Specify first point:
Either enter a specific co-ordinate or select a start point with a Left Click
Specify next point or [End/Close/Pgon/Arc/Line/Undo]:
Either enter a specific co-ordinate or select a start point with a Left Click.
This tool will remain active until you terminate it.

End will stop the drawing process and end your Pline at its current location.
Close will draw a line from your current position to the start point closing your Pline to a closed loop
Pgon will draw a line from your current position to create a loop and filling the space with a solid
block of colour.
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Arc will turn your next segment as an arc using your line width as the Arc radius.
Line returns your next segment to a line if previous was an Arc.
Undo will remove the last line segment you have drawn.

Examples of the tool options within Polyline

You can also smooth the shape of a polyline by changing the Fit Type value in the polyline properties.
For more information on Properties see the properties section of this document. Left Click the Polyline
and Right Click so it’s pink and select Properties from the menu. Left Click the field to the right of Fit
Type and from the dropdown select Quadratic B-spline. This will smooth out the lines to a curved
spline shape.
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Polygon – Creates a Polygon with sides and rotation using parameters input via Draw polygon
popup. Activate by selecting the Draw polyon icon from the Draw ribbon or type POLYGON<Enter>
at the command prompt. In both instances the Draw polygon popup will appear.

Select number of sides
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Select Radius (either Inscribed/Circumscribed to Circle

Select Rotation

The above example shows how the polygon radius is created in relation to a circle. The yellow
polygon is the only geometry you will see when using this tool.
You can create this shape without precise angles or radius by selecting the icon and using your
mouse to left click and drag your shape onto your drawing.
Using combinations of sides/radius and rotation will help create accuracy in our drawing.

Rectangle – To draw a rectangle select the Draw rectangle icon from the Draw ribbon or type
RECTANG<Enter> at the command line. In both case your will be prompted to:

Specify first corner:
Either enter a specific co-ordinate or select a start point with a Left Click

Specify second corner:
Either enter a specific co-ordinate or select a start point with a Left Click
If you align your next point using polar tracking to set the next co-ordinate 45˚ to your start and enter
1000<Enter> the tool will draw a rectangle with a diagonal width (top left to bottom right of 1000)
If you select 0,0 as the first point of your rectangle you can enter
1000,1000<Enter> to draw a square with a width/height of 1000)
500,1000<Enter> to draw a rectangle with a width of 1000 and a height of 500)
The format of this second prompt to draw a rectangle of specific dimensions is width,height<Enter>
This will only work if you select 0,0 to be the first point of your rectangle as the value are treaed as coordinate points rather than lengths.
For exact dimension rectangles use the Line command to draw each side accurately.

Spline - A spline is a smooth curve that passes through or near a given set of points. To start the
Spline tool select the Spline icon from the Draw ribbon or type the word SPLINE<Enter> at the
command line. In both cases you will be prompted to:
Specify first point:
Either enter a specific co-ordinate or select a start point with a Left Click
Specify next point or [End/Close/Pgon/Undo]:
Either enter a specific co-ordinate or select a point with a Left Click to set the first control point.
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Dragging your mouse around this point will form the curve. Additional points will add more curves
along your spline. If you enter any of the following responses this will be the result

END - prompt will change to:
Specify start tangent angle: followed by
Specify end tangent angle:
If you do not have these angles available entering <Enter> to both these questions will terminate this
tool and leave the spline geometry at its current state.

Close – prompt will change to:
Specify start tangent angle: If you do not have this value, enter<Enter> to calculate and close the
Spline back to its start point.

Pgon – prompt will change to:
Specify start tangent angle: If you do not have this value, enter<Enter> to calculate and close the
Spline back to its start point and fill the shape with a pattern of solid colour.

Undo – Will undo the previous segment and leave the toll active for the next response.

Circle – The circle tool is used to create circle geometry.

The tool can be activated by selecting the
Circle icon from the Draw ribbon or typing CIRCLE<Enter> at the command prompt. In both cases
you’ll be prompted to:
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Specify center point for circle or [2P/3P]: Left Click a point on your drawing to position the center
of the circle.
Specify radius of circle or [Diameter]: Enter a value in units (mm) for the radius of your circle
followed by <Enter>. This will produce a circle with your defined radius in your drawing.
If you select Select D<Enter> .The prompt will be replaced with:
Specify diameter of circle: Enter a value in units (mm) for the diameter of your circle followed by
<Enter> .This will produce a circle with defined diameter in your drawing.

Ellipse - Creates an ellipse shape. To activate this tool choose the Ellipse icon from the Draw
ribbon or type ELLIPSE<Enter> at the command line
Specify Centre point:
Either enter a specific co-ordinate or select a start point with a Left Click
Specify rotation angle and first radius:
Enter specific values e.g.90,25 (rotation 90, radius 25) or Left Click your points with the mouse.
Specify second radius:
Enter specific values e.g. 50 (radius 50) or Left Click your points with the mouse.

Arc – The Arc tool produces arcs. To active select the Arc icon from the Draw ribbon or type
ARC<Enter> at the command prompt.
Specify start point of arc or [Center]:
Either enter a specific co-ordinate or select a start point with a Left Click
Specify second point of arc or [Center/End]:
Either enter a specific co-ordinate or select a second point with a Left Click
Specify end point of arc:
Either enter a specific co-ordinate or select an end point with a Left Click
If you select C <Enter> to the second question the next prompt will be:
Specify center point of arc:
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Either enter a specific co-ordinate or select a start point with a Left Click. This will calculate the centre
of the arc as if it were part of a circle. This will prompt:
Specify end point of arc or [Angle]:
Enter a specific Angle value<Enter> or Left Click a point.
The rest of the tools available of the Draw ribbon (Insert Raster, Insert Text, Insert Block, Create
Block definition and Hatch) will be covered later in this document.

Drafting Aids
One key advantage of using Computer Aided Drawing tools for drafting is their ability to deliver
accuracy and ease of editing. Using the drawing tools on their own will not give you complete control
over the placement and management of geometry. To achieve the high level of accuracy required,
products such as GardenCAD build in functions known as Drafting Aids. These tools enable you to
add and modify elements in your drawings with ease and control.
Drafting Aids can be activated in two ways. One as a temporary action for a single specific task or as
a semi permanent setting that remains active during a session or until changed. Regardless of how
you activate these aids their function and use remains constant.
Deciding which aids to activate at what stage in your drawing session will become more apparent
with experience. It’s temping to enable all the aids with the view that you’ll never know when you may
need them. The trouble with this approach is that there are situations when two aids may conflict or
take priorty over each other overriding the one you actually need. When this occurs you’ll have to turn
them on and off at inconvienient times. As your drawing improves you’ll get to know which ones you’ll
use constantly and which ones you only need as required. Getting to know how you use both the
Drafting Aids Popoup and the Object Snap menu is critical if you want to be both accurate and efficent
with your CAD drawing session.
To activate a single aid while drawing select the Object Snap Menu and Left Click the required snap
from the dropdown. The advantage in doing this is it can be done while you are drawing and a tool is
active. Selecting a single snap will not terminate the drawing tool you are using at the time. These
snaps will only remain active for one action. For example if you select Line and want to attach it to an
existing line you can select to Endpoint and attach your line using the snap. If you then wish to add
another line you must select to Endpoint again for the next line. You can also active these Object
Snaps by selecting them from the Object Snap Ribbon
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If you wish to have the Endpoint Object Snap remain active during your session you must stop your
current drawing tool and enable End Point via the Object Snap Tab in the Drafting Aids popup.
To enable the Drafting Aids popup, Right Click anywhere on the black Model Space area and select
Drafting Aids from the menu. When the Popup appears Left Click the Object Snap tab

Here you’ll see a table with radio buttons to toggle on/off the Objects Snaps you wish to configure.
There are two areas that need to have a tick applied to make the snap active. Firstly enable the
Object Snap tools the Object Snap On (F3). If this box is not on none of the Snap choices will work.
The (F3) is the function key to toggle on/off the Object Snap tools.

The second area you need to activate is the specific snap or snaps required. If you do wish to active
all you can do this quickly by Left Clicking the Select All button. Clear all will de-select all.
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When drawing, the Object Snap will display a yellow symbol to indicate the element is in the correct
position. Each Object Snap has a specific symbol and is shown to the left of the Object Snap name on
the above list.
The following is a description of the basic function of each of the available snaps.
Endpoint – Snaps the start or end point of a new drawing element to the end point of an existing
element when the end point marker appears.
Midpoint - Snaps the start or end point of a new drawing element to the midpoint of an existing
element when the midpoint marker appears.
Center – Creates a center snap for a circle. The cursor must be over an existing circle edge before
the marker appears.
Node - Snaps the start or end point of a new drawing element to any individual points created using
the Draw > Point command.
Intersection - Snaps the start or end point of a new drawing element to any intersection of two
existing elements.
Perpendicular - Snaps the start or end of a new line when the new line meets an existing line edge at
a 90°.
Tangent - Snaps the end of a new line drawing element to a circle edge when that line end touches
the edge of a circle at 90°.
Nearest – Snaps a new drawing element to the edge of any existing drawing element.
Grips – Snaps the start or end point of a new drawing element to ends and center of existing lines &
arcs and 45° markers on circles and ellipses. The marker appears on corners of polygons as well as
4 points on closed splines. It appears in the center of rectangles when the cursor touches the edge. It
appears on all points of Polylines and Multilines.

Line weights
To separate your drawings geometry so its reads easier either on screen or page you can apply
different line weights or thickness to areas like borders, structures or features. Line weights can be
configured as a default setting to a layer or they can be applied separately by using the Lineweight
Settings popup.
Choosing the correct line weight size for your geometry is a personal choice and it’s worth doing
some simple tests to understand how they will look on your printed plan. As with any vector graphic
element, the line weight size you choose will stay consistent if you scale your drawing up or down or
zoom in or out. For example if you choose a line weight of 2 and then change your drawing to a scale
of 2 or a scale of.5, the line weight size will stay the same.
Hand drafting has traditionally been done using ink technical pens. Common sizes used were .35mm,
.5mm, 1mm and 2mm. All these sizes and more are available in GardenCAD3.3
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Setting Line weight Settings for a new layer
To set the default the Lineweight for a layer select the Lineweight icon from the new Layer window

The will set the Lineweight size to any geometry assigned to this layer. Be aware that changes to line
weight size in model space will only appear if you activate the Display Lineweight option in the
Lineweight settings popup.
To configure the default lineweight properties select either the Lineweight icon from the Object
Properties Ribbon or using the shortcut Ctrl-T. In both cases the Lineweight Settings popup will
appear.

24 | P a g e

In this window select the line weight from the Lineweights list; the units (size) for your line weight and
whether or not you want the line weight changes displayed on your drawing in Model Space

Changing default will change the default line weight size. The adjust display scale alters the relative
line sizes on the screen but not on your printed output.

Changing line weight to existing geometry
To change the line weight of a element select it so it turns pink and select the required line weight
from the dropdown on the Object Properties ribbon.

This will change the line weight for the chosen element(s). If you select By Layer each element will
reflect the size of the line weight for the layer that element is associated with. If you change this to
anything other than By Layer you will change the chosen elements to that new value.
The best way to check your printout will look that way you want is to do a test print to a .PDF file. This
will show all your line weights before final printing. See the Printing section later in this document.
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Line types
Adding different line types to your drawing is another way of giving variation and emphasis to sections
of your drawings. By default GardenCAD does not have any linetypes other than a solid line. You can
however install others including dotted lines by using the Linetype tool.
To active Linetypes select the Linetype icon from the Object Properties Ribbon or typing
LINETYPE<Enter> at the command prompt. In both cases the Linetype popup will appear.

By default there is only a Continuous line available. To install more select the Add from file... button.
A windows browser window will appear. In here there will be a series of additional LineType files
available. Each will install a set of line patterns. Select your set and press the Open button
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This will activate the Load Linetypes from a file popup. Either select the individual line type by clicking
the left hand side of the filename so a tick appears and the file turns red, or in this example choose
the Select All button to tag them all. If you highlight the filename you’ll see a preview of the pattern in
the Preview window

This will now add a series of new line types to your selection list. To active a line type select a pattern
from the Linetype dropdown listing and choose your line tool and begin to draw. Rather than drawing
a solid line it will use the new line pattern. All the standard drawing commands will work as normal.

27 | P a g e

If you wish to change an existing element to a different line pattern, select your geometry so it’s pink
and select your chosen Linetype from the Linetype dropdown

This will change your line to the new pattern.
If you have already installed your additional Linetypes you also add them as a default pattern when
you create a new Layer.

Modifying Tools
Once a segment or segments of geometry have been added to your drawing you will be required at
some stage to modify them. Modifying parts of your drawing can be as simple as deleting them or as
complex and trimming or extending their length. In each situation the geometry you wish to alter will
be placed in a mode that enables it to be modified. If you Left Click any individual piece of geometry it
will change to a dotted pink colour. This change is an indicator so you know when the element is in a
changeable state. If you wish to select multiple elements Left Click them one at a time. To unselect
any element hold the Shift Key and Left Click again. Selecting Right Click and Unselect All from the
menu will de-active everything in your drawing.
You can select multiple elements using a selection window (Sometimes referred as a Marquee Box)
If you Left Click and hold your mouse Top Right in the Model Space outside where your geometry is
positioned and drag it down diagonally to Bottom Left. This will form a box or window around your
selection. (Make sure you keep the Left Click held down while dragging). Once you’re happy the
window is covering all your elements, release the mouse and Left Click again. Everything that sits
completely inside the window will turn pink and be in modify mode. Note that anything that the window
crosses will not be included in this selection. If you do need to select all elements then cancel this
selection by hitting the ESC key and follow the same process but this time starting Top Right and
dragging to Bottom Left. This will select everything inside the window and anything the window fame
crosses.
There is variety of selection options from the Select Menu from the Top Toolbar include patterns and
selecting elements like identifier, Text or various patterns.
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Undo/Redo
If you make an error while drafting or modifying your drawing you can undo your previous
command(s) by selecting the Undo button from the Standard Ribbon. Redo is the icon pointing
clockwise.

You can also use the shortcut Ctrl Z and Ctrl Y to produce the same result. Hold down the Ctrl key
and press Z for Undo and Hold down the Ctrl key and press Y for Redo.
You can Undo and Redo and number of commands in a row by simply repeating it one after another.

Properties – When any element is created and added to your drawing a list of properties is saved
describing all the critical detail that go together to form that item. You can view these properties at any
time by Left Clicking the element so it’s Pink and either selecting the Properties icon from the Modify
Ribbon or Right Click and select properties from the popup menu. Once selected the Properties table
will appear. Many of these properties can be changed however it is advisable not to alter anything
unless you understand the impact of the change. Once you have become familiar with the fields in
these lists they can offer a useful resource to change aspects of your geometry dynamically.

The values available in the properties will vary depending on the piece of geometry you are viewing.
For example Circles will include values for Radius while Lines will include Lengths.
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Erase – With your geometry selected Left Click the Erase icon from the Modify Ribbon
You can also erase by using the Del Key on your keyboard or Right Click in Model Space and select
Erase from the Menu. You can also type ERASE<Enter> at the command line. If you do not select
your geometry prior to selecting this tool you will be prompted:
Select objects (right button to stop)
Left Click the pieces of geometry one by one. Each time you select a piece the command line will
display
Select objects: 1 found, 1 total will appear. This total value will increment with multiple selections.
Once you and selected all your elements press Right Click to terminate the prompt and delete your
items.

Copy – Copy enables you to produce duplicates of your geometry and re-use those in other parts of
your drawing. To activate this tool select the Copy icon from the Modify Ribbon or type
COPY<Enter> at the command line. In both cases the following prompts will appear.
If you do not select your geometry first you will be asked to:
Select objects (right button to stop)
Left Click the pieces of geometry one by one. Each time you select a piece the command line will
display
Select objects: 1 found, 1 total will appear. This total value will increment with multiple selections.
Once you have selected all your elements press Right Click to terminate the prompt and you will now
be asked:
(If you do preselect your geometry this will be the first prompt you see after selecting the tool.
Specify base point or displacement:
Left Click a position on or inside your object to copy from. You may choose to activate an Object Snap
to help with accuracy. Think of this as grabbing hold of your copy.
Specify second point of displacement or <use first point of displacement>:
Either enter a specific co-ordinate or select or value in units (mm) <Enter>. You can Left Click to this
prompt to place your copy. For accuracy you may use a Drafting Aid to position your copy accurately.
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Move – To move a piece of geometry from one location to another select the Move icon from the
Modify Ribbon or type MOVE<Enter> at the command line. In both cases the following prompts will
appear:
If you do not select your geometry first you will be asked to:
Select objects (right button to stop)
Left Click the pieces of geometry one by one. Each time you select a piece the command line will
display
Select objects: 1 found, 1 total will appear. This total value will increment with multiple selections.
Once you have selected all your elements press Right Click to terminate the prompt and you will now
be asked:
(If you do preselect your geometry this will be the first prompt you see after selecting the tool.
Specify base point or displacement:
Left Click a position on or inside your object. You may choose to activate an Object Snap to help with
accuracy. Think of this as grabbing hold of your geometry.
Specify second point of displacement or <use first point of displacement>:
Either enter a specific co-ordinate or select or value in units (mm) <Enter>. You can Left Click a
position to place your geometry. For accuracy you may use a Drafting Aid to position your copy
accurately.

Rotate – The rotate command enables you to rotate your geometry. To activate this tool select the
Rotate icon from the Modify Ribbon or type Rotate<Enter> at the command prompt. In both cases
the following prompts will appear.
If you do not select your geometry first you will be asked to:
Select objects (right button to stop)
Left Click the pieces of geometry one by one. Each time you select a piece the command line will
display
Select objects: 1 found, 1 total will appear. This total value will increment with multiple selections.
Once you have selected all your elements press Right Click to terminate the prompt and you will now
be asked:
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Specify base point:
Left Click a position on or inside your object. You may choose to activate an Object Snap to help with
accuracy.
Specify rotation angle <10.0>:
(Note the value of 10 is the default 10˚. This will be replaced with each new angle supplied.)
Use your mouse to rotate your geometry and Left Click to complete rotation or enter a specific angle
value (e.g. 90 for 90˚) <Enter>.
If you hold the Shift key each time you answer this it will place a copy of your geometry in the new
rotation while leaving the original in place. This is useful if you want to copy a pattern around a single
pivot point.

Scale - The scale command enables you increase or decrease the size of geometry based on a
scaling factor value. To activate this tool select the Scale icon from the Modify Ribbon or type the
word SCALE<Enter> at the command line. In both cases the following prompts will appear.
If you do not select your geometry first you will be asked to:
Select objects (right button to stop)
Left Click the pieces of geometry one by one. Each time you select a piece the command line will
display
Select objects: 1 found, 1 total will appear. This total value will increment with multiple selections.
Once you have selected all your elements press Right Click to terminate the prompt and you will now
be asked:
Specify base point:
Left Click a position on or inside your object. You may choose to activate an Object Snap to help with
accuracy.
Specify scale factor <1.0>:
(Note the value of 1 is the default scale factor of 1. This will be replaced with each new factor
supplied.
Enter a scale factor value. Scale factor 1 is the current size. Scale factor .5 is half the size and scale
factor 2 is twice the size etc. You can also use your mouse to drag the geometry in or out followed by
a Left Click to get a manual scale change.
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Mirror - The mirror command is different from copy in that it produces a reflected copy along a
mirror line. To activate this tool select the Mirror icon from the Modify Ribbon or type
MIRROR<Enter>at the command line. In both cases the following prompts will appear:
If you do not select your geometry first you will be asked to:
Select objects (right button to stop)
Left Click the pieces of geometry one by one. Each time you select a piece the command line will
display
Select objects: 1 found, 1 total will appear. This total value will increment with multiple selections.
Once you have selected all your elements press Right Click to terminate the prompt and you will now
be asked:
Specify first point of mirror line:
Either enter a specific co-ordinate or select a start point with a Left Click
Specify second point of mirror line:
Either enter a specific co-ordinate or select a start point with a Left Click
The mirror copy will be placed on the other side of the virtual mirror line. The original piece of
geometry will not remain unless you hold the Shift key down while answering the Specify second
point of mirror line: prompt. If you follow this process you will retain both elements on either side of
the mirror line.

Example of the difference between copy and mirror

33 | P a g e

Explode – The explode tool is used to break apart geometry that has been joined together from
individual elements. To activate this tool select the Explode icon from the Modify Ribbon or type
EXPLODE<Enter> at the command line. In both cases the following prompts will appear:
If you do not select your geometry first you will be asked to:
Select objects (right button to stop)
Left Click the pieces of geometry one by one. Each time you select a piece the command line will
display
Select objects: 1 found, 1 total will appear. This total value will increment with multiple selections.
Once you have selected all your elements press Right Click to terminate the prompt. The geometry
you have selected will be exploded.
If you preselect your geometry before you select this tool there are no prompts. The tool will attempt
to explode your selection as soon as you activate the tool.
Take care when exploding elements such as polylines, circles or blocks as these may break your
geometry into unmanageable pieces.

Join – The Join tool will join together separate pieces of geometry.

To activate this tool select the
Join icon from the Modify Ribbon or type JOIN<Enter>at the command line. In both case the following
prompts will appear:
If you do not select your geometry first you will be asked to:
Select objects (right button to stop)
Left Click the pieces of geometry one by one. Each time you select a piece the command line will
display
Select objects: 1 found, 1 total will appear. This total value will increment with multiple selections.
Once you have selected all your elements press Right Click to terminate the prompt. The geometry
you have selected will be joined. Not all geometry can be joined and may not work in some situations.
For example two lines need to be joined at a common end point for them to be joined. Attempting to
join one at a midpoint of another will not.
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Trim – If you wish to remove portions of geometry such as lines that are too long use can use the
Trim tool to shorten them. To activate the Trim tool select the Trim icon from the Modify Ribbon or
type TRIM<Enter> at the command line. In both case the following prompts will appear:
Select cutting edges...
In order to remove a length of a line you need to use another piece of geometry as a cutting edge that
either crosses or touches the point where the line will be cut back to. Think of this line as a knife that
will cut off what you don’t want.

Left Click the pieces of geometry you wish to use as cutting edges. In this case there is only one.
Select objects: 1 found, 1 total will appear. This total value will increment with multiple selections.
Right Click when you have selected all your cutting edges.
Select object to trim or shift select to extend:
Left Click the section you want to remove.
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This will be the result

You can now remove the Cutting Edge line if not required, or in this case you could repeat the
process and remove the end of the pink line. This time the Green line would become the Cutting Edge
and the Pink section at the top the object to trim.

Extend – You can use this tool if you need to extend a line to a boundary to fill a gap. To activate
this tool select the Extend icon from the Modify Ribbon or type EXTEND<Enter> at the command
line. In both case the following prompts will appear:
Select boundary edges...
Select objects: 1 found, 1 total will appear. This total value will increment with multiple selections.
Right Click when you have selected all your boundary edges.
Boundary edges are where you want to extend you line to.
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Select object to extend of shift-select to trim:
This is the line you wish to extend.
This is the result.

All the Modify commands can also be activated by selecting them from the Modify Menu on the top
toolbar.

One tool that is on this menu but not of the Modify Ribbon is Offset.
Offset – Offset allows you to make a copy of a piece of geometry and offset it a certain distance from
the original. You can also start the Offset tool but typing OFFSET<Enter> at the command line. In
both case the following prompts will appear:
Select objects (right button to stop)
Left Click the pieces of geometry one by one. Each time you select a piece the command line will
display:
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Select objects: 1 found, 1 total will appear. This total value will increment with multiple selections.
Once you have selected all your elements press Right Click to terminate the prompt and you will be
asked:
Specify offset distance or [Through]
Enter a distance in units (mm) to offset your copy.
Specify a point on side to offset to
Left Click the side of your original you want the offset copy to be positioned.

Using Layers
Once you have gained a practical understanding of the drawing and modifying tools, you need to start
thinking about how you can lay your drafting project out so it can be managed easily. The most
effective way to do this is the use of Layers. Layers allow you to separate your geometry into
separate virtual groups. These layers can have individual properties applied to them such as colour or
locks from editing or ability to print. Mostly they are used to temporarily remove geometry from the
model space by changing the viewable state of the group. This helps when your drawing is complex
and you have difficulty controlling what geometry belongs to what section.
Think of CAD layers like parts of a drawing broken up and placed on separate pieces of clear overhead projector cells. When you layer them on top of each other you’ll see the complete drawing
projected on the screen. If you only want to see certain sections or your drawing you can remove a
cell or cells. In this context layers are just CADs equivalent to these cells.
Before you start to use Layers it’s a good idea to think about what layers you’ll need for your drawing.
They can be added anytime but it’s a good idea to map critical groupings before your start so your
drafting session has a good flow.
Activating the layers tools can be done from two places. You can either use the Layer Menu from the
top toolbar or use the Layer and Layer order icons from the Object Properties Ribbon.
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Creating and managing Layers
Both options will activate the Layer popup. You can active Layers by typing LAYER<Enter> at the
command line.
Using layers is broken into two sections. Firstly you create and edit layers and layer properties by
selecting Layer from the menu or icon.

When you make this selection the Layer popup will appear. It is in here you create and edit your
layers.
When opening a new document there will only be one layer available. Layer ‘0’ is the default. Unless
you create new layers and change their active status all geometry will be applied to this layer until
changed.

To create a new layer, select the New button from the top. A new layer will be created with a default
name (In this case Layer 1. This name will increment by one if you leave these names as default. To
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change this name and any other properties you wish to set for this layer select the Details button from
across the top.

Here you can change the Layer Name, Geometry colour, Line weight for this layer, and Line Type.
(Additional Linetypes can be added by using the Linetype tool discussed previously in this
document.
You can also manage the visibility in the Model Space by click the Invisible Box. This is also done
using Layer order discussed later in this manual. You can also lock this layer from Editing. A small red
closed lock icon will appear if this is set. This is useful if you don’t want to accidentally change any
geometry while you’re working. You can also inhibit anything attached to this layer from appearing on
your printout when you produce a hardcopy. The On/Off button toggles all layer visibility states to On
or Off. The invert button will change the current visibility states to the opposite.

The active layer is the layer that is currently receiving new geometry when it’s drawn. The active layer
is found on the Object properties Ribbon.
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To activate a layer so it will receive new geometry Left Click the layer from the active layer dropdown.
In this example House Footprint would become the new active layer. This will now stay in this state
until changed. Just adding layers will not make them active by default. You must make them active as
required.
Once you have began to build a drawing and adding it to layers you will need to be able to manage
their visibility and order. This is done by using the Layer order Tool. This can be activated by choosing
Layer order from the layer menu or by select the Layer order from the Object Properties window.

When you select either of these it will active the Layer order popup.

Here the popup displays three available layers. 0, House Footprint and Irrigation.

In above example you can see there is no geometry displayed in the Model Space. You’ll notice a
Yellow/Grey globe to the left of the layer name. This indicates if a layer is visible or not. In this case
yellow is on for layer 0 but there has been no geometry applied to that layer. Both HouseFootprint and
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Irrigation is toggled off. To change the state simply Left Click the globe. It will toggle to the opposite
state. If it is on it will go off and if off visibility will be on.

Visibility for HouseFootprint clicked on

Visibility for Irrigation clicked on. Now all layers are on.
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If you accidently create geometry while having the wrong layer active you can change this. First
ensure the layer you want the geometry attached to is available. In this example the rectangle
representing a garden bed was drawn while the House Footprint was active.

To change Left Click any geometry you intend on moving so it’s pink. Then from the Object properties
Ribbon select the new layer you want this geometry attached to. In this case GardenBed1. Once you
selected it the selected geometry will be applied to the new layer and will take on any associated
properties. In this case Line Colour is pink.
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Changing the stacking order
Once you start to build your drawing with a number of different overlapping layers you may notice that
some of your geometry is hidden by others. In situations where you want those layers stacked in a
specific order you can do that in the Layer Order popup.

In this example the three colours are attached to a separate layer. Currently the Layer Order reflects
the way the three colours are stacked.
To change this order so the blue circle moves above the red Left Click and hold the Blue Layer in the
Layer Order popup. The text will change to a red colour. While holding the Left Click down, drag the
layer up above Red and Green.
Now Blue is on top and the geometry order has changed. You can move layers down as well.

This is useful when creating layers with paving and furniture where you want to create the illusion one
sits above the other.
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Hatch Patterns
Often your drawing will require blocks of colour or areas of pattern to represent different surface or
construction materials. To save time and effort a variety of patterns can be applied by inserting areas
of Hatching to your drawing. Hatching is essentially a tiled block of geometry that can be applied to a
closed boundary. There are a variety of hatching patterns available and the process to include them
requires a few specific steps to be followed to create a successful effect.
To activate the hatching tool you can either select Hatch from the Draw menu from the top toolbar or
select the Hatch icon from the Draw Ribbon.

You also activate the Hatch tool by type HATCH<Enter> at the command line. In all case the Hatch
Popup will appear.

Before using this tool you need to ensure you have setup the geometry correctly that will contain the
hatch pattern you desire.
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The basic law of hatching is that in can only be applied to a closed boundary. The segments that go to
make up the boundary can be individual elements but there must be no gaps. For example a square
made from 4 lines is ok as long as each end is attached to the end point of another. Any gaps will
cause the hatching process to fail. Circles for example are closed and will accept a hatching pattern
without any issues. The best tool to use when drawing areas ready for hatching are polylines. This
tool is perfect as it is drawn as one continuous piece of geometry and when you terminate with a
Right Click you have the opportunity to select ‘Close’ which will ensure your working within a closed
boundary. (See Polyline in the Drawing Tools section)
When you have confirmed you have a closed area to hatch activate the Hatching tool as above.

To choose a hatching pattern select the dropdown from the Pattern Area of the Hatch popup.

To help scroll through the available patterns once you select one you can hover your mouse over the
Pattern field and use your middle mouse button to scroll through. You can see the patterns displayed
in the preview window.

There are two other parameters you may need to change depending on your application.
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You can alter the rotation of the pattern. This can be handy if you wanted to emulate a paving pattern
at 45˚. If you change the Angle: field to 45 the pattern will rotate that number of degrees. The other
field you may have to experiment with is the Scale: When patterns are produced they are saved as a
scale factor 1. This can vary depending on what pattern was draw by the supplier. In many situations
scale factor 1 is too large or too small. You can change this to suit.
Once you have parameters set in this panel select the Pick Entities button.
When you do this the popup will disappear and the cursor changes to a small hatch pattern. Now left
click the closed boundary area where you wish to apply the pattern. If you are attempting to use a
boundary made of separate segments you must Left Click each one. In either situation when a
boundary line is selected the geometry will change to a solid magenta.

Once you’ve selected your boundary entities select Right Click and OK from the Hatching Popup
when it re-appears.
Your hatching pattern should then be applied inside your boundary.
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If you find you get either no pattern appearing, a small solid area in only a portion of your boundary or
your pattern looks too large you may need to adjust the scale factor. To do this select and Left Click
an area on the hatch pattern so it turns pink.

Select the properties tool from the Modify Ribbon or by Right Click and select properties from the
menu. To alter the Scale size change, the value next to Scale at the bottom of the properties table.
Values of .5 will make the scale half the size and 2 will be double. You only get some many attempts
at changing this before you will have to remove the hatch (Left Click to make pink and hit Del key) and
apply the hatching again. Next time use a different scale value at the beginning of the process.
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If you have a situation where you wish to insert a hatch pattern between two closed boundaries select
both boundaries when you select Pick Entities. By selecting both, the tool will calculate the space
between the two entities and fill that space.

Hatching pattern will be placed between the two boundaries.
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Text
Including text into your drawing is an important part of the drafting process. Text can be used to
describe sections of your plan, add lists of information such as plants or materials, or simply to record
project information like client, address or version detail. Text is best included in combination with
layers. This makes the management and control of your text easier. Working with text comes in two
parts. There is the style component where you decide the font styles and size and there’s the
creation, placement and maintenance of text within your drawing.
By default GardenCAD has a Standard text style configured at installation time. You can if you wish to
insert text straight away by using the Text tool. However it’s best to understand how to use the Text
Style function first. This will give you the ability to create different font styles and make them available
during the drawing process.

Setting Text Style
To active the Text Style Popup you need to select Settings from the top toolbar and then Text Style.

The Text popup will then appear
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In the Text Style popup you’ll see information about the current text styles configured and the ability to
create your own.
In this example there is currently only the Standard style configured. The preview will give you a view
of what this style will look like in your drawing.
To create a new Text Style select the New button

The New Text Style popup will appear. Enter the name for your Text Style
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You can now configure you style to match your needs. Here the Font Name: has been changed to
Arial. This font has been installed with the GardenCAD product. This default height is set in the
Height: field. This parameter is often overwritten when inserting Text with the text tool. You can distort
the test by changing parameters in the Effects area. Ticking the Upside down and Backwards tick
boxes will do as described. Changing the values in Width Factor: and Oblique Angle: will distort the
text style look.
Once you are happy with your changes select OK to complete.
Now you have created a new Text Style you need to change the style of any existing geometry or set
the style for anything new.

Insert Text
To insert Text into your drawing you can select Draw then Text from the top toolbar.

When selecting Text from the Top Toolbar you’ll be asked to choose from 3 options.
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Mutiline Text - Gives you the ability to create a longer string of text. You can also type
MTEXT<Enter> at the command line. In all cases you’ll be prompted to:
Specify first corner:
Either enter a specific co-ordinate or select a start point with a Left Click
Specify opposite corner:
Either enter a specific co-ordinate or drag mouse to form a box and Left Click
The Edit Multiline Text popup will appear. Type your text and select OK

This will add you multiple line text into your drawing as one element. You can use the modify tools to
Copy, Modify or scale if you wish to change. It does have limited formatting. To do a line feed hit the
space key twice then Enter.

Single Line - Gives you the ability to create a longer string of text. You can also type
TEXT<Enter> at the command line. You can also select the Text icon from the Draw Ribbon.

In all cases you’ll be this prompted to:
Specify insertion point of text:
Either enter a specific co-ordinate or select a start point with a Left Click
Specify height <value>: (value was the height entered the last time this tool was activated)
Enter a height value in units (mm) or move your mouse vertically up and Left Click the approx height
you want the text.
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Specify rotation angle of text <value>:
was activated)

(value was the rotation entered the last time this tool

Enter a rotation angle or drag you mouse to the right so the text box rolls clockwise. Left Click when
the box is horizontal.

The Create Text popup will appear. Enter you’re text in the Enter Text: field. There are a number of
parameters you can change within this popup. One is the Style. Select your Style from the dropdown
if you wish to use a text style other than the default Standard. If the text style you want to use is not
available you’ll next to create it using the Text Style tool in settings. See Setting Text Sytle in the
previous section of this document.

Windows Text - Gives you the option to create text using some simple alignment and formatting
tools. This tool can also be started at the command line by typing WTEXT<Enter>. In both cases
you’ll be prompted to:
Specify insertion point text:
Either enter a specific co-ordinate or select a start point with a Left Click
Specify height <value>: (value was the height entered the last time this tool was activated)
Enter a height value in units (mm) or move your mouse vertically up and Left Click the approx height
you want the text.
Specify rotation angle of text <value>:
was activated)

(value was the rotation entered the last time this tool

Enter a rotation angle or drag you mouse to the right so the text box rolls clockwise. Left Click when
the box is horizontal.
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The Create Text object popup will appear.

Enter your text in the Enter Text: Field. There are a number of text formatting options that use can
use to assist with placement and look of your text.

Change Text Style
To change the text style of existing Text Left Click the Text so it’s pink.

While Pink select the Properties icon from the Modify Ribbon or Right Click and select Properties from
the menu.
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From the Properties table select the Style field and then choose the Text style you have created from
the dropdown. The Text Style of your selected geometry will change. Press the ESC key or Right
Click and select Unselect All from the menu to terminate the pink modify mode. You can also change
the text content by selecting the Contents: field. Left Click and press the small button will three dots.
The Edit text Popup will appear. Change the text and select OK

Raster Images
A Raster Image is a computer graphics term for a photographic image as opposed to a piece of
vector geometry created by the CAD program. Using photographs in your designs will give them an
added level of detail not easily matched by drawing. They are also an excellent guide or pattern when
producing geometry based on actual objects. They are also valuable when aerial photographs or
Google Earth Images are all you have for larger sites with difficult access.
Most image formats are now available in GardenCAD3.3. To check your image type will import select
Information from the Top Toolbar and Plugins
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The Plugins popup will appear. In here you can see which image extensions should work. If there is a
plugin available and it does not have a tick next to it click and your file type should be available.
The important thing to understand about Raster Images inside CAD drawings is that they do not
actually become part of the geometry or file. When adding a photo to your drawing the only
information recorded is a path to the folder where the photo resides. If you insert photos from various
locations and these locations change you will see only an empty frame in your drawing with some text
listing the path where the image came from. You cannot change this path once you have inserted
your image. If the image moves to another location then you’ll have to re-apply the image into your
drawing. The easiest way to overcome this issue is to create a standard Folder structure for all your
CAD images. If you create a Folder on your folder in c: drive in the GardenCAD folder called Pictures
(c:\GardenCAD\Pictures) and replicate this on any of the machines you are most likely to use, then
the image path will always have the same. If you’re concerned about being able to send your CAD
drawings to people who won’t have this file structure then that won’t be an issue. Normally CAD
drawings are printed to .PDF files for distribution not as raw CAD files. These documents will have
your photos imbedded with the rest of your drawing. This will be discussed later in the printing
section.
Its worth noting that if you are using photos in your drawings that are not your own and your drawing
will be used for commercial gain then be aware of possible copy right issues. Images not licensed for
general use should not be used without permission. If you do then it may cause legal issue further
down the track.
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You can insert an image into your drawing by selecting Draw from the top Toolbar and then selecting
Insert Raster Image

You can also choose the Raster Image Icon from the Draw Ribbon or type the word IMAGE<Enter>
at the command line. In all cases Insert Image popup will appear.

If you’re inserting a new image select New. (If you have previously added a photo into your current
drawing you may get a prompt about saving an image on the clipboard. Say No to this question)
You will now see the Select File popup
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Select your photo

The filename of your file and the path should be reflected in the Name: and Path: fields. If these are
correct then select the Insert button. Your cursor will change to show that the Insert Raster process is
active. At the command prompt you’ll see:
Specify insertion point:
Either enter a specific co-ordinate or select a start point with a Left Click
Specify scale (pixels per model unit)<value>: (value was the scale entered the last time this tool
was activated)
Enter a scale value or drag you mouse to form a frame and Left Click

Your image is now inserted into your drawing. It is now a frame and treated like any other piece of
geometry. You can Left Click the image box and make it pink and use any of the modify tools like
Copy, Move or Scale to position it where you want. Note however that you must have the image
rotated to the correct orientation before you insert it. The rotate tool will not rotate the image like an
image editor but will rotate the frame around a pivot keeping the image at the same orientation.
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Dimension Lines
Dimension lines are tools that enable you to apply measurements and guides to your drawing without
having to manually measure and draw lines with text. The configuration and application of dimension
lines is managed by two separate sets of tools. The style and configuration of the lines are done using
the Dimension Styles popup and the application of dimensions is done with the Dimension Tools. It’s
a good part of your workflow to setup all your styles whether it be dimensions or general text before
your start your drawing. Setting these up once and saving them as your standard template is also a
good idea.

Setting the Dimension Style
You can active the Modify Dimension Style popup from either by selecting Dimension Style from the
Settings menu on the top toolbar

You can also select Dimension Style from the Dimension Ribbon or by typing DIMSTYLE<Enter> at
the command line: In each case this will active the Modify Dimension Style popup.

The Modify Dimension Style popup contains has 4 tabs. Each tab has a series of fields you can use to
configure different components of your Dimension line setup.
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List Tab – Lists the different styles you have setup and have available to your drawing. The default is
Standard – its good practice to leave this unchanged and create new ones for your other styles.

The New Button setups a new style profile.

A default DimStyle 1 will be created. If you do not change these the number will increment by one. It’s
a good idea to give these useful names otherwise you will find it difficult to know when you have lots
of different styles which one is which.
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The Current active dimension style is displayed next to Current Dimstyle: To make your new DimStyle
active, highlight it in the Styles: window and select the Set Current Button.

To remove an unwanted style, highlight it in the Styles: window and select the Delete Button.
When you create a new style it will populate the fields with the same items as the standard style. You
must now change the items in each tab to configure the style to suit your project.
Lines and Arrows – Will change the types of arrowheads and dimension lines are configured. To see
how your setup will look in your drawing you can them reflected in the preview window.
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Text –The text tab is the area you use to set the text style and placement of text around your
dimension lines. Use the Setting Text Style process in the Text section of this document to configure
available text styles in the Text style: dropdown. The default is the Standard style.

Units -The units tab is used to configure the values that appear next to your dimension lines. When
applying dimension lines to your drawing in Model Space, these default values should be sufficient.
You may choose to change the precision if you want your unit values rounded up to the nearest whole
number. Generally values for Measurement Scale: and Overall scale for dim. Features: are changed
when the geometry scale is set ready for printing. For a description of how these fields should be
configured see the Printing section later in this document.
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Inserting Dimension Lines
There are several different options for inserting dimension lines into your drawing. Some need to be
used for specific situations. To enable accuracy dimension lines should always be applied with the
appropriate snaps. Also to help manage the view and access to your drawing it’s a good idea to apply
all dimension lines to a separate layer. This way they can be turned off and on when required.
To activate your dimension line, select the Dimension menu from the Draw selection from the top
toolbar.

You can also select the specific Dimension tool from the Dimension Ribbon.

Linear Dimension- Applies Dimension lines to horizontal or vertical geometry.
Select Linear Dimension from the Dimension Ribbon or type DIMLIN<Enter> at the command line:
In both cases you’ll be prompted:
Specify first extention line origin:
With the End Point Object Snap active Left Click the first end of your geometry.
Specify first extention line origin:
With the End Point Object Snap active Left Click the second end of your geometry.
Specify dimension line location:
Move your mouse away from your geometry and Left Click to position your line.
(If you cannot see your dimension value you may need to configure your text height to be a large
value. Refer to the Text Tab in the Setting Dimension Style section.)
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Aligned Dimension- Applies Dimension lines to non horizontal or vertical geometry. If you apply
a Linear Dimension Line to a non vertical, horizontal line you will not get an accurate length but just a
measurement parallel to the x or y plane.
Select Aligned Dimension from the Dimension Ribbon or type DIMALI<Enter> at the command line:
In both cases you’ll be prompted:
Specify first extention line origin:
With End Point Object Snap active Left Click the first end of your geometry.
Specify first extention line origin:
With End Point Object Snap active Left Click the second end of your geometry.
Specify dimension line location:
Move your mouse away from your geometry and Left Click to position your line.
(If you cannot see your dimension value you may need to configure your text height to be a large
value. Refer to the Text Tab in the Setting Dimension Style section.)

Ordinate Dimensions – Are not dimensions but a display the X and Y coordinates attached to a
leader.
Select Ordinate Dimensions from the Dimension Ribbon or type DIMORD<Enter> at the command
line: In both cases you’ll be asked:
Specify feature location:
Left Click the point you wish to apply the label.
Specify leader endpoint:
Left Click the point to wish the leader to end.

Radius Dimension – Applies a dimension label with the radius of the circle or arc you have
chosen. Use the Center Object Snap when using this command.
Select Radius Dimension from the Dimension Ribbon or type DIMRAD<Enter> at the command line:
In both cases you’ll be asked:
Select arc or circle:
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With Center Object Snap active Left Click the Arc or Circle
Specify dimension line location:
Drag your mouse and Left Click the end of the label with the radius value. Value will begin with R for
Radius

Diameter Dimension – Applies a dimension label with the diameter of the circle or arc you have
chosen. Use the Center Object Snap when using this command.
Select Diameter Dimension from the Dimension Ribbon or type DIMDIA<Enter> at the command
line: In both cases you’ll be prompted:
Select arc or circle:
With the Center Object Snap active Left Click the Arc or Circle
Specify dimension line location:
Drag your mouse and Left Click the end of the label with the diameter value. Value will begin with Φ
for Diameter

Examples of Linear, Ordinate and Radius dimensions
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Angular Dimension – Applies a dimension label displaying the angle between two lines, arcs or
circles. If you selecting and angle between two lines use the Nearest Object Snap to attach to the
lines.
Select Angular Dimension from the Dimension Ribbon or type DIMANG<Enter> at the command
line: In both cases you’ll be prompted:
Select arc, circle or line:
Left Click to attach to the first line:
Select second line:
Left Click to attach to the second line:
Specify dimension arc line location:
Drag your mouse away from the angle and Left Click. This will form an arc dimension line with a value
in degrees.
Dragging your mouse to the opposite of the angle will display either the same angle or an- angle
against one plane of one of the line depending where you’re mouse is in relation to the angle your
measuring.
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Quick Leader – Applies a simple leader with text to an area on your drawing.
Select Quick Leader from the Dimension Ribbon or type LEADER<Enter> at the command line: In
both cases you’ll be prompted:
Specify first leader point:
Left Click the start of your leader
Specify next point:
Left Click another point to fort a leader line.
Specify next point:
Right Click to display the Create Leader Popup

Enter your leader Text and select OK.
If your leader text is too small, Left Click the leader so it’s pink and in modify mode. Right Click and
select properties and change the Text Height to a larger value.
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Center Mark – Place a Cross marker at the center of a circle or arc. Use the to Center Object Snap
to position the marker accurately
Select Center Mark from the Dimension Ribbon or type CENMARK<Enter> at the command line: In
both cases you’ll be asked:
Select arc or circle:
With the Center Object Snap active Left Click to place the marker

Measuring Tools
Apart from applying dimension lines directly to your geometry, you may need to measure lengths or
distances during the drafting process. To do this there are specific tools available that will give you
distance and area. These tools are often useful after the drawing is complete. For example you may
wish to calculate an area for lawn or paving. Using the Area tool will give this information anytime.
Measuring tools do not create geometry but return values based of the points you measure from and
to. They generally don’t require additional geometry to work though in some situations you may need
to add a temporary marker to create a fixed point to measure from. It’s important to note that
wherever you do anything with measurements you should always use Object Snaps where possible to
assist with accuracy.
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For some types of geometry you can also get some information from the properties table. For
example if you draw a line of 1000mm and if you Left Click so it’s pink and Right Click and select
properties you’ll see at the bottom of the table a field call Length. This is the actual measurement in
units of that piece of geometry

You can change this value to extend the length however be careful how you use it. If you create a line
by starting at a particular snap point then extending length here could cause problems at that point.
To activate the Measuring Tools select the Distance tools from the Information menu on the top
toolbar.

You can also select the Measure Distance, Measure Area and Area by inner point from the Standard
Ribbon.
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Measure Distance – Measure distance between two points.
Select the Measure Distance icon from the Standard Ribbon or type DISTANCE<Enter> at the
command line: In both cases you’ll be prompted:
Specify first point:
With the appropriate Object Snap active Left Click for start distance.
Specify next point:
With the appropriate Object Snap active Left Click to end distance. (If you hover over this point you
can read the current distance if the yellow label attached to the cursor.

If you Left Click then read the distance result in the Command line.
If you wish to continue on a measure another point you can or Right Click to terminate the tool.

Distance along polyline – Measures the distance along a polyline from a start point.
This tool is not available of the Standard Ribbon. You must select this from the Information menu from
the top toolbar
Specify a polyline:
Left Click the polyline.
Specify first point
Left Click a start point along the polyline
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Specify next point
Left Click the end of the polyline where you wish to measure. The polyline will turn red between your
first point and last point. This is the length that is measured and will be displayed in the command line
and on the yellow label next to the cursor.

Measure Area - Measures the area of a space by selecting boundary points.
Select the Measure Area icon from the Standard Ribbon or type AREA<Enter> at the command line:
In both cases you’ll be prompted:

Specify first point of polygon:
With the appropriate Object Snap active Left Click to first point of the area you are measuring.
Specify next point of polygon:
With the appropriate Object Snap active Left Click to the next point of the area you are measuring.
This will start to create virtual polygon calculating the area as it builds.
Specify next point of polygon:
With the appropriate Object Snap active Left Click to the next point of the area you are measuring.
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After three points have been selected you can start to see the current area in mm² in the yellow label
next to the cursor.

Specify next point of polygon:
With the appropriate Object Snap active Left Click to the next point of the area you are measuring.
Keep moving around the area selecting each point. When you Left Click the point where you started
the tool will calculate the total area in mm². You can read this value in the command line.

To convert the value to m² divide the value by 100000 or move the decimal 6 places to the left. The
tool will remain active and start a new series of prompts. Right Click to terminate the tool.
If your shape is unusual like an open organic area made from a Spline, use the Nearest Object Snap
and Left Click a series of points around the boundary following the same process as above. The more
points the more accurate the calculation will be. This is used if the shape is not closed. If the
boundary is closed use the Area by inner point tool described next in this document.
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The area will be calculated and displayed in the command line in mm². Divide by 1000000 or move
decimal 6 places to the left to get m². Right Click to terminate tool.

Area by inner point- Measures the area of a space by selecting a point within closed
boundary.
Select the Area by inner point tool from the Standard Toolbar. The AREA<Enter> command will not
start this tool but the Measure Area tool.
Pick a point inside of polygon, use <Shift> to add/subtract an area
Left Click a point inside the closed space.

The area will be calculated and displayed in the command line in mm². Divide by 1000000 or move
decimal 6 places to the left to get m². Right Click to terminate tool.
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If you’re measuring an area with two boundaries inside each other and you only want the area in the
space between the two, then Left Click the outer space then hold the Shift key down and Left Click
the inner. This will subtract the inner area leaving the gap between the two. The area with the pattern
is what is calculated. Right Click to terminate tool.

Blocks
A block is a bundle of geometry grouped and saved as a single object. Creating blocks is an efficient
way to re-use parts of your drawing in either your current plan or in other projects. The process of
drawing geometry for blocks is no different from any other drawing with GardenCAD. What’s different
is how you save them so you can use them again later.
You can assign attributes to blocks using the Define Attributes Tool. This will be described in the
Other Tools section at the end of this document. These are not critical when creating all blocks. If you
wish to do this you will need to define these before you complete the Create Block process.

Creating and Saving Your Block
Before you saving parts of your drawing as blocks there’s few basic rules that’s worth considering
before starting.





While you can selectively save objects as blocks while you’re drawing a larger plan, blocks
are easier to manage if you draw them each as a separate drawing or as a group of related
objects. For example if you draw a garden seat save this block in a drawing called garden
seat with nothing else in it. Or if you have groups of similar shrub symbols keep them together
in their own drawing as shrubs.
Give your blocks a meaningful name. If you’re saving a piece of garden furniture then call it
something that describes your object.
Keep layers to a minimum and avoid having geometry on Layer 0. If blocks are brought into
your drawing with a layer already used there could be issues with your block layers affecting
your main drawing layers. This is much easier to manage if you create your blocks as
standalone drawings.
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To center you block start the first element at 0,0. This will make it easier when you insert this
block into other drawings.
If you’re drawing your own plant symbols, create them inside a 1x1 metre box. This will keep
all your plant symbols the same start size of 1m² at the scale of 1.This way scaling is easier
by applying a simple scale factor when displaying accurate canopy.
Don’t save the box as part of your block. This is object used as a guide when you are
drawing it.

Once you have completed your drawing select all the geometry by selecting each element so it’s pink
or use a marquee box to select all. Once everything is pink you can Right Click and select Create
Block from the menu
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You can also select the Creates a block definition from the Draw Ribbon or type BLOCK<Enter> at
the command line. In each instance the Block definition popup will appear

The selected geometry that will form your block is displayed in the Preview window. Ensure the
Convert to block option is selected and you give your block a meaningful name.
The popup will disappear and your geometry will no longer be pink. Now if you Left Click on any part
of this object you’ll notice that the entire group will turn pink and react as one object.
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You’ll also notice there is a series of small blue squares or handles. Each of these gives you a
specific control of the block.
To activate the handles Left Click each one and drag your mouse to perform the action. The diagram
below describes the function of each handle.

Stretch
vertical

Move

Scale

Stretch
horizontal

Rotate

You can also use the Modify Tools to Copy, Move and Scalee your blocks within your drawing.
This block will now be attached to this drawing. In order to use this block in other drawings save your
CAD drawing with a name the same as your Block. This way it will be easy to find when you want to
re-use it in another project.

Inserting Blocks into your drawing
Inserting blocks into your drawings can happen in two ways. Firstly you can insert another copy of a
block that is already associated with your open drawing in again. Or you can bring a new block in from
a file.
To insert a block you can active the Insert Block popup by selecting the Insert block from drawing
from the File menu
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You can also activate the Insert Block popup by selecting the Insert Block icon from the Draw
Ribbon or by typing INSERT<Enter> at the command line. In all cases the Insert Block popup will
appear.

The Insert Block popup gives you a variety of options when selecting your block. The Name: block
dropdown will display any blocks currently available in you drawing. This will not include all blocks you
have created outside this drawing. These will be covered in the next section. You can choose
Insertion Point, Scale or Rotation but generally you can do these from within your drawing. Selecting
Explode will explode your block when inserted. This option is best left unchecked unless you are sure
you want to do this.
Once you’ve selected your Block and OK the block will be attached to your cursor. Left Click to place
the object in your drawing. You can now use Left Click to make pink and use either the blue handles
or modify tools to distort of place your block as you wish.

Inserting Blocks from a file
To insert a block from a separate .vec file start the Insert Block process selecting Insert block from
drawing from the Draw menu on the top toolbar or selecting the Insert Block icon from the Draw
Ribbon or typing INSERT<Enter> at the command line. In all cases the Insert Block popup will
appear. Having a good folder structure on your computer will make it easy to know where your Block
files are stored.
If this is a new drawing you’ll notice that the Name: dropdown selection list will be empty. This is
because there are no blocks inserted into your drawing.
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To activate the search blocks process select the Blocks button. This will activate a Blocks popup.

From here select the Add from file button and this will display the Select File popup. Using your
mouse select the .vec you have created containing your Block geometry. You will see a preview of all
the geometry in that file. Select the Open button when you have confirmed the correct file has been
selected.
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Now the Add blocks from file: <file name> will appear. The <file name> is the block file you have
chosen. Left Click the small box to the left of the file name under Selected and also Add the whole
drawing as one block.

Left Click the Block Name and select close.

Make sure the correct block name is selected from the Name: dropdown and choose OK. Left Click
on the model space where you want your Block positioned. Depending on your zoom level you may
have to zoom out to see it. Use the handles or Modify Tools to resize and position.
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Symbols Library - Plant and General
GardenCAD comes with a number of plant and general blocks available a pre-installed symbol library
accessible via the Library from the Top Toolbar.

The Library is divided into two main sections. There are plant symbols available from the Plant
Selector and General Symbols from the General Details option. Each menu selection is broken into a
series of submenus and folders. Once you select the area you are interested in you’ll find a series of
CAD .vec symbol files. If you Left Click the file name you can see a Preview of the symbol in the
Preview window.

Once you have chosen the correct symbol select the INSERT button.
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This will insert the symbol at 0,0 (Center) of your drawing. To move or change, Left Click to place the
block into modify mode and either use the handles or the Modify tools to distort, copy or move the
symbol.
Depending on the symbol you have chosen there will be a layer created automatically as part of the
insert process. Others will be applied to the current active layer directly. It’s a good idea to create a
layer for your symbols regardless. If you wish to alter the layer the block is attached to when you
insert it you may have to explode it first. (See Explode in the Modify section of this document)
Changing the layer associations without exploding first may have unpredictable results.

Printing
Printing your CAD drawing can be considered in two ways. You can print a version un-scaled directly
to either an attached printer or PDF driver. This is the simplest most direct form of printing and needs
little setup or manipulation. The other produces a document at a readable scale on a specific size
piece of paper or to a PDF. In both instances the Print functions are managed via the Print popup.
This can be activated by selecting the Print menu option from the File menu on the Top toolbar.

You can also activate print by selecting the Print icon from the Standard Ribbon or type
PRINT<Enter> at the command line. In all cases the Print popup will appear.

The following procedure assumes you have the appropriate printer driver installed and configured on
your machine. If you intend printing to a PDF file for printing at another location ensure you have the
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appropriate PDF driver installed on your computer. For information on installing a free driver refer to
the Printing to a .pdf file section at the end of this chapter.

Non Scale Printing
From the Print popup ensure you have selected the correct printer. To change the Printer Device
select the change button

And select the correct printer from the dropdown.

Also choose your desired paper size and orientation. Select OK when printer selection is complete.

84 | P a g e

Select the area to print by choosing the Window button and Pick.

Left Click top left of your drawing and drag box down to bottom left enclosing the area you wish to
print. Left Click again and from the print Popup select the Print Preview Button to check your printout
looks OK. Right Click and select Print or Exit to return to the Print popup.

Your printout will be sent to the selected output device.
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Printing to Scale
The process for printing to scale printing uses the same Print popup tool as basic printing. The
difference is the preparation of the scaled version. All CAD drawing is done at a scale of 1:1 or its
actual size, printing anything larger that the paper size you wish to print to will need to be scaled in
some way.
GardenCAD uses a method of creating a virtual page the size of the paper you are printing to and
moving your drawing over to that space and applying a scaling factor to your geometry to make it fit.
In order to understand what scaling factor you will need you must decide a few things prior to printing.




What is the size (width or height depending on your paper choice and orientation) of the
drawing you wish to print?
What size paper and orientation are you printing to?
Are you printing directly to an attached printer or to a .pdf device?

Once you have decided on these points you can prepare your scale printing.
Firstly it’s a good idea to set your output device before your start the PAGES process. This is useful
as the type of printer will determine what paper sizes are available in the pages setup. To select the
output device choose Printer Setup from the File menu on the Top Toolbar or select Print from the
Standard Ribbon and select the Change button next to Printer Device.
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Using Pages to create a virtual printing page
To create a virtual sheet of paper select Pages from the Top Toolbar and then Create/Edit Page

The pages popup will appear
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Give your page a meaningful name. You may choose to configure different versions on different sized
paper. If you include the paper size in the page name it will make it easier to choose from the select
page menu. Make sure you select your page size here. The available paper sizes will reflect the
printer you have setup for printing. If you wish to print to a large size like A1 then a normal home
printer will not have that size available. For larger sized paper you’ll need to choose the PDF driver as
your output device. Finally choose the orientation of your output. Note that orientation terms are
different here. Book is used for Portrait and Album is used for Landscape. Press OK when
completed.

Make a note of the size of the paper you have chosen. This is important when calculating the scale
factor.
Once you’ve created your virtual page you need to transfer a copy of your drawing and scale it to fit.
From the pages area you need to return to the Model Space. To do this select Pages from the Top
Toolbar and choose either Select Page then Model or First Page from the menu. Both will return you
to your drawing.

Use the Measure Distance Tool to measure the width and Height of your model drawing Include any
space you might like on either side. If you’re planning to include a name block in your final print you
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may wish to consider that here. Understanding this measurement is important as this will help us
calculate the scale factor to use for the size paper you plan to print to.
You should now have the Width (or Height) of the area you want to scale. Assume width is the value
we need to consider as widest part is the horizontal part of our drawing. If you were printing using a
Portrait orientation then the height of your drawing may be more appropriate to use in the scale factor
calculation.
Here we will use Page Width (Width of paper) and Drawing Width (Measured width of drawing)
To calculate the scale factor required you need to perform a simple calculation.
Here’s the formula
Page Width (mm) / Drawing Width (mm) = Scale Factor
Or
Page Height (mm) / Drawing Height = Scale Factor
E.g. To print a drawing that is 20 meters wide and 10 meters high on A3 (Landscape) you need to
420 / 20000 = 0.021
The closest value to this on you scale ruler is 0.02 or 1/50
If the scale factor had have been 0.019 then you either have to round up to .02 (1/50) or down to .01
which is 1/100. You need to find a scale factor that matches the standard scale ruler a builder may
use.
To help here’s a list of the scale factors and their respective scale values.
Metric Scale (on your Scale Ruler)
1:10
1:100
1:20
1:200
1:25
1:250
1:30
1:300
1:40
1:400
1:50
1:500

CAD Scale factor
0.1
0.01
0.05
0.005
0.04
0.004
0.0333
0.00333
0.025
0.0025
0.02
0.002

To help understand the width and height of standard paper here’s a table of A4 - A0
Paper Size
A4
A3
A2
A1
A0
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Paper Dimensions (mm)
210 x 297
297 x 420
420 x 594
594 x 841
840 x 1189

If you have been requested specifically to deliver your drawing on a particular size paper you need to
select a scale factor that is the neatest fit given the size of your drawing.
The easiest way to do this is to measure you’re drawing as above and just multiply by the scale
factors until you get one that fits the best.
For example to fit our drawing that’s 20 meters x 10 meters on A1 we need to find a scale factor that
will expand that drawing to paper that is 841 mm wide.
E.g.
20000 x 0.01 = 200 (too small)
20000 x 0.1 = 2000 (too large)
20000 x 0.02 = 400 (too small)
20000 x 0.04 = 800 (good fit. This will scale your drawing to 1:25 on A2)
Now you have the scale factor calculated you need to move a copy of your drawing onto your page
and prepare it for printing.
Make sure you are on the page with your model. Zoom out so you can see your complete drawing.
Place a marquee box around your drawing (Left click the top left and drag down and right the opposite
bottom corner and left click. Your drawing will be pink and in Edit Mode.
Select Edit and ClipBoardCopy

This will make a copy of your drawing and place it on the Clipboard. Do not use the standard windows
copy/paste (Ctrl C and Ctrl V) to do this. You must use the ClipBoardCopy/ClipBoardPaste options for
this to work.
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Once you’ve completed the ClipBoardCopy select PAGES from the Top Toolbar then Select Page
and choose the virtual page you have prepared for printing.

Now select Edit from the Top Toolbar and choose ClipBoardPaste
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Your drawing will appear in Pink and your virtual page will appear small in comparison.

Now Right Click and from the Menu select Scale
Specify base point:
Enter 0,0
Specify scale factor <1.0>:
Enter the scale factor you calculated for this page. In this example it was .02
This will scale your drawing to fit the chosen paper. However if you have used Dimensions as part of
your plan these do not scale properly.
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To resolve this issue you can change the Dimension Style parameters to scale these to match the
new scale.
The settings below reflect this example. Some experimentation may be required depending on the
size of the output you are producing. Only the Units changes are predictable as they match the scale
factor you have used.

Arrow size needs to be reduced

Measurement Scale: should match the scale units. In
this example scale is 1:50 so 50 is entered
Overall scale for dim features: should equal the
scale factor used. In this example .02

Text Height: needs to be reduced
size needs to be reduced
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These values have to be returned to the defaults after printing as they are common to all pages
including the model space. If you leave them you may not be able to read them when returning to
your drawing.

Final Print
Once you have finished setting your output device and scaling your document select File and Print
from the top toolbar or selecting the Print icon from the Standard Toolbar Ribbon

As you have scaled this using the pages process the Print Area button should be active next to Paper.
If you wish to do a final preview you can select the Preview Button. If everything looks OK Right Click
and select Print from the Menu. If you wish to skip the Preview just select the OK Button. If your
printing to a .PDF file your may get some filename and file location questions (See Printing to .PDF)
otherwise your printout will be sent to your designated printer.

Alternative Method
To overcome this issue with dimensions being distorted during the scaling process you can do the
following.
Rather than do the ClipBoardCopy and ClipBoardPaste process you can highlight your drawing and
turn it into a block. Give it a block name of MainPlanPrint. Then go to your virtual page and select
Insert block select MainPlanPrint andscale it as per your scale factor calculations. With this method
the dimensions are frozen and appear as they do in Model Space. Use this process if you don’t wish
to make any changes to your drawing prior to printing. If you do you will need to explode your block
and this will cause the dimensions to scale again causing the same distortion issue. Remember your
drawing in Model Space is still a block and will need to be exploded prior to any further changes.
For further information check the Scale Printing Video at GardenCAD website:
http://www.gardencad.net/web/sites/default/files/A2Sheet.wmv
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Printing to a .pdf file
What is a PDF file and why use it?
PDF or Portable Document Format is a file format developed by the Adobe Corporation. It has
become a pseudo standard for document distribution in a compact, platform independent way. PDF
files can contain images, text and hyperlinks and can to be transported anywhere and processed
without having the CAD software installed that created it. All the receiving device requires is a working
Adobe PDF reader to view or print your drawing.

Standard Printing Flow

User generated output (e.g.
CAD drawing)

Your PC’s printer uses a specific
printer driver to convert and
print to your printer. You need
GardenCAD to read the drawing
file

Output is printed directly to
your printer

Print to Adobe Driver

User generated output (e.g.
CAD drawing)

Adobe PDF Writer creates a
standard format file.

Use Adobe Acrobat reader to view
and or print using the standard
printing process. File can be E-mailed
to printers for printing. GardenCAD
does not need to be installed.

What you need
In order to print using the Adobe print output process you’ll need to download and install a PDF writer
onto your PC. Once this is installed, it will appear like any other available printer on your printer list.
Here’s a quick summary.
1. To create (print to) PDF files you’ll need a PDF Writer.
You can get CutePDF for free from http://www.cutepdf.com/Products/CutePDF/writer.asp
Select Free Download and Run, Run and accept license
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You make get a question to install a
PS2Converter. Click ‘yes’ to this pop
up.

When the install process is complete, check that the CutePDF is available by checking your installed
printers.
Do: Start/Control Panel/Printers and Other Hardware/View installed printers or fax printers.

CutePDF

If you find you are not happy with the CUTE PDF you can try PRIMO PDF. This can be downloaded
from this site:
http://www.primopdf.com/

Just follow the questions to download.
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Other Tools
Importing and Exporting DXF
GardenCAD3.3 now gives you the ability to import and export CAD files in DXF extension. DXF or
Drawing Exchange Format was developed by Autodesk to enable their Autocad products to share
drawings with other products. GardenCAD can now exchange drawings with any product able to
operate with this file format. This includes Autocad and Sketchup. (Note dxf import functions is now
only available in Sketchup Pro or versions 7 and earlier. For later free versions you will need a
separate Plugin.
http://help.sketchup.com/en/article/161784

Exporting GardenCAD3.3 to dxf format files
To export a drawing to a dxf file select File and Export DXF

Choose a filename and location to save your exported file.
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To open your converted GardenCAD file in AutoCAD select Open and select the file from your saved
folder. Make sure you have selected the DXF extension in the Files of type: field.

Your file should now open. Check your drawing for accuracy. Tools such as measure should return
the same dimensions as the source.
To import your file using Sketchup Pro select File and Import from the Top Toolbar. Make sure you
have selected the DXF extension in the Files of type: field and select your file.

Use the top view button to position to view your imported drawing. When dxf drawings are imported
using this process the geometry will have no faces and be locked as a component. To edit the
geometry you can select and edit component or select and explode. To explode use the Select Tool
to select the component so it turns blue.
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Right Click and select Explode.

To create faces you may have to draw over some of the edges to re-define the closed boundaries.

Importing dxf format files
GardenCAD3.3 can also import dxf format drawings from other programs. Select File and Import
DXF.. from the Top Toolbar.
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In the windows search popup select DXF drawing file from the extension field. Then select your file
and Open and you CAD file will be imported in GardenCAD

Export Raster
GardenCAD3.3 now has the option to export a snapshot image of your drawing via the Export Raster
option. Select File from the Top Toolbar and Export Raster

This will activate the Export to Raster Image popup.

100 | P a g e

Select your output folder and file name. Select your Output regions. Extents will fill the frame with the
best fit of your drawing, Display will be as you see on the current view and Window will activate the
Pick button which will generate a frame you can draw around the area you want exported. Select OK
when all the selections are complete. A raster image of your drawing will be sent to the output file
specified.

.BMP Raster Image using Extents view

Assigning Attributes to Blocks
Assigning attributes to a block is done separately from the Create Block process. Defining attributes
are values (text or numbers) that perform like labels on the Block. The advantage of these attributes is
that you can change them at any stage using the Attribute Edit or Attribute Manager Tools without
exploding the block. The sequence to this process is to define the attribute first and place it with the
block geometry before combining it all with the Create Block Tool.
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To activate the Define Attribute tool select the Define Attributes from the Settings Menu from the Top
Toolbar. You can also type ATTDEF<Enter> at the command line. In both cases the Attribute
Definition popup will appear.

Select the Mode to display the Attribute by setting the Mode, Tag and Value. The Tag is the Attribute
Label. Value is the Data you’ll see displayed with the block if the mode is not set to Invisible.

The Height parameter may need increasing depending on the size of your drawing. Select the Pick
Point button and Left Click a point in Model Space with the block geometry you have drawn. When the
popup returns select OK.
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You’ll notice the text in this example is the Tag: field. At this stage the attribute is not combined with a
block

Now select the attribute and all the block geometry and make it pink. Right Click and select Create
Block

Once the Block is created the Value: field is displayed
To change this field without exploding the block select Attribute Edit from the Settings menu. At the
prompt:
Select block:
Left Click the Block with the attribute. The Edit Block Attributes popup will appear. To change the
attribute text in the block, replace the Value: field and select OK.
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Using the Grid
GardenCad3.3 has a non-printable grid available to assist drawing tasks that require specific spacing
and alignment. The grid points will allow geometry to be snapped to nodes that are set at specific but
configurable intervals. To activate the Grid tools popup, Right Click anywhere in Model Space and
Select Drafting Aids. Then select the Grid Tab. To toggle the Grid on or off select the Grid Button at
the bottom of the Command Line or enter the shortcuts (F7) to Show Grid and (F9) to Snap to Grid
Nodes.

When you show the Grid you will two sets of nodes. The small points in this example are spaced 1
unit (1mm) apart and the Cross Points or Bold step are 10 units (or 10mm) apart. Both these are
configurable. With the Snap to Grid Nodes active Left Clicking on a node will snap to it as if attaching
to a line with and Object Snap active. There is no indicator as with Object Snaps but if you zoom in
you’ll see the line attach. In the example above the square was drawn by Left Clicking the 4 Bold Step
nodes that are set to 10 mm apart. You can separate these markers by changing the colours or the
marker styles.
The Grid is useful if you wish to draw pattern like paving that has specific measurements.
To remove the Grid, toggle off the Show Grid and Snap to Gridlines or use the function keys (F7) and
(F9). If you don’t intend on using the grid system, make sure you toggle off both options. If you leave
the Snap to Gridlines active while the Show Grid is off you may notice your cursor hopping around
when try to attach a piece of geometry to your drawing. This is because the process is trying to attach
your new element to a node you can’t see.
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3D views
The latest version of GardenCAD includes a series of orthographic and isometric views of your 2D
drawing. These represent your 2D drawing by either moving the model Space Viewport around your
drawing Top or Bottom, Left or Right, Front or Back and well as SW Isometric, SE Isometric, NE
Isometric NW Isometric. These views can be configured using Viewport Presets popup. You can
activate these views by selecting the chosen view from the 3D Views option from the View menu on
the top toolbar.

Top and Bottom views are looking directly down or up at your drawing plane. Left/ Right are looking
along the X axis and Front/Back looking along the Y. It should be noted that these views will not
present the sides of your drawing by showing closer lines obscuring lines behind. When two lines are
on the same plane then the one drawn first will appear to cover newer lines. To separate lines in this
context you must manage them with layers.

Top view
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`
View Right. Notice colours reflect the view from right to left in the Top view.

View Left. Rather than show the blue and yellow lines as you would think you see the same pattern as
the left view only reversed. This is because the view is not showing what elements are closest to the
camera but what have been added to the drawing first.
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You can overcome this issue for each by changing the draw item of the element. If you’re sure the
element you a viewing is obscuring another you can use the Draw Order command from the Modify
Menu from the Top toolbar. From here choose Bring to Front or Send to Back

This will place the obscuring element underneath the one you want to see or access

Isometric views
These views change the horizontal and vertical angles of the drawing plane. The change of axis is
shown in the bottom left hand corner.

These views alter the vertical and horizontal axis of your drawing plane. You can configure these
presets by selecting the Viewpoint preset option from the 3D views menu.
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The Viewpoint Presets popup will appear. From here you can alter the Horizontal and Vertical angle
of the viewpoints.
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Insert ArcView Shapefile...
ArcView Shapefiles are a geospatial vector format used by GIS mapping systems. Shapefiles are
generally downloaded from survey or mapping sites. Some care should be taken when inserting
Shapefiles into your drawing. These files can be large and generate a lot of geometry. Before
inserting a Shapefile into your drawing it’s a good idea to save your work. To insert an ArcView
Shapefile select Insert ArcViewShapefile from the Draw menu

From the Select File popup select your Shapefile. Ensure you select the .shp file extension and select
Open.

109 | P a g e

In this example the map is South Australia by region. Each region is drawn from the Shapefile
information as separate closed polylines filled with a solid colour.

Database SppDb
The SppDb is a specially design database you can purchase and install that will run as a compliment
to your CAD drawings. To active the Plant Database select Database – SppDb from the Library menu
from the top toolbar. If you do not have the Plant Database installed you will be taken the Spp
Website where you can purchase and download the software.

If you do have the database installed the Plant Database will open in a separate window.
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The use of this database will not currently be covered in this document. For further information of this
product go to the Plant Database page at this link;

http://www.plantdatabase.gardencad.net/

Sustainability Calculator
The Sustainability Calculator is a tool to help you create a sustainability summary of key elements of
your project. Choosing this option generates a spreadsheet that is saved and associated with your
project. Using this function is not described in this document.
To install the calculator go to this link and follow the instructions. You will need to have Microsoft
Excel installed first.
http://www.gardencad.net/web/?q=node/126
Once the calculator is installed on your computer select Sustainability Calculator from the Library
menu on the Top Toolbar.
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Once Microsoft Excel starts Select open the LanscapeSustainabilityCalculator from the folder you
have installed it.

For more information on this calculator visit:
http://www.gardencad.net/web/
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